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Introduction
The Australian Pictorial Computer Stamp Organiser (APCSO) is a combined catalogue and 
inventory system with a number of novel features. It has been produced by Stamps.AU Pty. 
Ltd.

Features of the new product include:

Inventory fields and catalogue prices for mint stamps, first day covers, Used, Blocks of 
four, Imprint Block of four and Relevant First Day Covers.
An image of the watermark has been included where this is necessary to identify the 
particular stamp. Absence of a watermark image does not necessarily mean the paper is 
not watermarked as most stamps issued prior to the early 1950s were on watermark 
paper.
Separate entries have been included in the latest version for Australia Post Stamp Packs 
and decimal stamp booklets.
The ability to generate wants lists that can be sent to your favorite dealer or Stamps.AU 
for fulfillment.
The ability to search for stamps by purpose, year range, description, size and/or value.
Future minor updates optionally available through the Internet.

Pricing in the catalogue is based upon retail values for good quality stamps. The prices 
quoted for relevant cancellations can only be regarded as indicative of commonly available 
material as some cancellations can attract a very high premium. The range of relevant 
postmarks is outside the scope of this Organiser.

Used stamps have light cancellation. Heavy cancellation will reduce value and fine 
cancellation including CTO may command a premium. 

In determining the number of varieties to be included, we have deliberately only selected 
colour descriptions that can be reasonably identified by the average collector. We have not 
included varieties that depend upon fine variation in colour shades for identification.

2
©2010 Stamps.AU Pty. Ltd

A.B.N 89 078 698 610

http://www.stampsau.com.au/


The Australian Pictorial Computer Stamp Organiser Version 8.0.0
User Guide

Numbering System

Pre-decimal:
Pre-decimal stamps have a sequential number (eg - 407 is the 8d version of the 50th 
Anniversary of ANZAC. There may be a suffix to indicate a sub-type.  Sequential numbering 
is also used on pre stamped envelopes.

Decimal:
For decimal issues, we have used an index numbering system using the format:

yyynnnn

where yyy is the last three digits of the year of issue and nnnn is a sequential number 
within that year. The first two digits of the nn sequence refer to the sequential issue number 
within that year. The last two digits in the nn sequence indicate a stamp or stamp product 
in that issue.

As collectors may have other numbering systems derived from other paper based 
catalogues, we have also introduced another searchable field called "Your number". For all 
stamps to the end of 1996, it is initially set up with the appropriate Seven Seas Stamps 
catalogue number but it can be changed to any other number (alpha-numerics permitted) 
that the user desires.

Entries from 1997 onwards, the initial entry is the Stamps.AU index number but this can 
also be changed.

Postage Dues.
The numbering system adopted is:

PA000

Where:

First alpha character is either P (Postage Due) or S (Specimen).

Second alpha character

A - Australia
N - New South Wales
V - Victoria

The number is a sequence number within that alpha block.
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Installation

System Requirements
To run The Australian Pictorial Computer Stamp Organiser you will need (at minimum)

Java™  Runtime Environment 1.6.0_17 (or better)
IBM compatible PC 
Windows 98 (or better)
SVGA capable graphics card/monitor set at 800 x 600 resolution or better
CD ROM drive
800 Megabytes free Hard Disk space
64 Megabytes Memory
PIII 800 or better processor.

Install

Java™ Runtime Environment
The APCSO version 8 runs on the Java™ platform (version 1.6.0_17 or better). A Java 
Runtime Environment will be installed automatically as part of the installation process.

APCSOv8
To install The Australian Pictorial Computer Stamp Organiser, insert the supplied CD into 
the appropriate drive and the installer should automatically start. If it does not, from the 
Windows Start Menu, select “Run” and type “d:\APCSC_windows_8_0_0.exe” 1

Once started, the setup programme will prompt you for the destination directory. If you 
would like to install to a different directory then make your changes here. If install it in 
another Drive, you need to specify the name of the required destination directory. The 
programme will generate the new directory if necessary.

After selecting the install directory, click on the computer Icon and the installation will 
occur.

Running the programme
To run The Australian Pictorial Computer Stamp Organiser, select the APCSO icon from the 
Windows Start Menu

1 If your CDRom is specified by a drive letter other than d: then enter the appropriate drive 
specification
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Usage

The File Menu

Import from a backup file

This will allow you to import data that you have previously backed up. All data contained in 
all of your collections will be replaced with the data contained in this backup file. To import 
your data, simply select the backup file that you wish to import.

Note: You are given the option of selecting whether the backup file is of a single collection 
or of multiple collections. 

To continue, select Next. 
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Import from a backup file (cont)

You are then presented with the option of importing the data into a new collection or an 
existing collection. If you select the existing collection option, use the drop down box to 
select the correct collection. The imported data will overwrite the existing data.

Select Next.

You are then presented with the folder selection screen. Use Browse to select the folder in 
which your backup file is located.

The file name to be selected will be of the format collnamedateexport.cbf where:
file-name is the name of the single collection backed up, date in dd-mm-yyyy format is the 
date on which is was backed up. This enables you to revert to a previous backup if desired.
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Import from a backup file (cont)

This works in a similar manner except the backup file to be selected will be in the format 
apcsov6date.obf. Note the .obf extension (not .cbf) and the name apcsov6.. which 
indicates it is a backup file of all collections, not a single collection.

Backup All Collections
To make a backup copy of all your data, select the drive/directory where you would like 
your backup saved to and press the Backup Collection button. This will backup all of your 
data in all available collections.

7
©2010 Stamps.AU Pty. Ltd

A.B.N 89 078 698 610

http://www.stampsau.com.au/


The Australian Pictorial Computer Stamp Organiser Version 8.0.0
User Guide

The Collection Menu
When first using your Australian Pictorial Computer Stamp Organiser, the data is entered 
into collection named "general". This collection can be renamed as required using the name 
change at Collection|Rename Current Collection. This (and other commands) is accessed 
through the Tool Bar at the top of the program window.

Additional collections can be created using the Collection|Create New Collection command.

Changing between collections is accomplished by the Collection|Set Default Collection 
command.

With multiple collections, you are able to delete data sets no longer required using the 
Collection|Delete a Collection command. If you only have one collection, this cannot be 
deleted.

It is strongly recommended that all collections be backed up to external storage on a regular 
basis. This may done individually by the Collection|Backup Collection command. By default, 
this is saved to the installation directory. It is good practice to have this saved to an 
external location (such as a floppy) by using the browse command made available on the 
Export Data command box.

NB: Remember that this command only exports the current collection. It is necessary to 
select other collections individually if they are also to be individually backed up.

All collections can be simultaneously saved using the File|Backup all Collections command. 
By default, this is saved to the installation directory. It is good practice to have this saved to 
an external location (such as a floppy) by using the browse command made available on the 
Backup Data command box.

If necessary, this saved copy can be imported into the Organiser as needed using the File|
Import from a Backup command (see information under File Menu).

NB: When importing, it is recommended that a new collection be created to bring the data 
into. This is necessary as the import will overwrite any data already stored in this collection.
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Create new collection
Creating a new collection for you to use is easy. Select an appropriate name for your new 
collection using Collection|Create New Collection command and you are done. If you would 
like the new collection to be loaded by default when you start the APCSO then check the box 
provided in the Load Collection command box.

Delete a collection
This will delete the selected collection2. Once deleted you will be prompted to set a new 
default collection (if necessary).

Rename Current Collection
Allows you to change the name of the current collection.

2 You must always have at least one collection. If you have only one collection and wish to 
delete it then create a new collection first and then delete the original.
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Backup Collection
Unlike the backup all function under the File menu, this will allow you to only back up the 
data contained in the selected collection. To make the backup copy of your data, select the 
drive/directory where you would like your backup saved to and press the export button.

To import this data back into a collection, see the Import from a Backup File command.
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List current collection
This command will list the stamps that you have indicated form part of your collection.

It will list the Index number of each stamp, its issue price, description and will list the 
number of Mint, Fine Used, First Day Covers, Blocks of 4, Relevant First Day Covers and 
Imprint Blocks of 4 that you have in your collection. You are also able to print the list of 
stamps in your collection from this screen.

When viewing your collection listing or your wants list, double clicking on an item will take 
you through to the relevant stamp details screen.

The contents of this list can be exported to an .rtf file by pressing the Export to File button. 
An .rtf files can be opened by your word processor for editing/printing.
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Set Default Collection
Allows you to load and work on a different collection. By checking the "Set Default 
Collection" box the collection you choose will become the default which will be loaded each 
time you start the APCSO.

Value current collection
The Value option from the Collection menu will provide you with a breakdown of the number 
of Mint, Used, FDC, Blocks of 4, Relevant First Day Covers and Imprint Blocks of 4 in the 
current collection with their value along with a combined value for your collection.

A check box is provided so that you will be able to obtain the same information but based 
on ALL collections, not just the one currently selected.

Pricing in the catalogue is based upon retail values for good quality stamps. 

Used stamps have light cancellation. Heavy cancellation will reduce value and fine 
cancellation including CTO may command a premium.

Covers are assumed to be clean with no creasing or damage to edges

The contents of this screen can be exported to an .rtf file by pressing the Export button. 
An .rtf files can be opened by your word processor for editing/printing.
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Wants List
The Wants List generated by the product can be printed for processing by or emailed to your 
favorite dealer. The file generated is in XML format and can be viewed in a web browser 
such as Internet Explorer (Version 5. and above).

Subsequent acquisition of an item held on the Wants List will remove that item from the 
Wants List. If further copies are required, it may be reentered in the Wants list for 
subsequent action.

Each collection maintains its own wants list so changes to one will not affect data stored in 
the others.

When viewing your wants list, double clicking on an item will take you through to the 
relevant stamp details screen.

The contents of this list can be exported to an .rtf file by pressing the Export to File button. 
An .rtf files can be opened by your word processor for editing/printing.
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Searching for an Stamp
The Australian Pictorial Computer Stamp Organiser has a comprehensive database that 
enables information to be stored and, most importantly, extracted for later use. Searches 
can be made for the whole database or confined to stamp entries that are present in your 
collection.

Search Entries

Searches of the database can be made in several ways:

Index Number 
Face value
Description (select a keyword that you would expect in the stamp description)
Year Range
Your Number
Notes that you have entered about the stamp.

While searches can be made with multiple fields, our experience is that it is more efficient to 
limit the search criteria and then visually inspect the search results for the desired stamp.
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Search Results
This screen will list all the stamps that matched your search criteria will be listed in the right 
hand box of the main Search screen. Double clicking on an entry will bring up a more 
detailed display for that stamp.

If your search produced more results than can be displayed on one page, you may scroll 
down or up through the results. You can reduce the number of results found by increasing 
the number of search terms that you used when defining your search criteria.

Clicking on the image of a stamp will display its description in the text area at the bottom of 
the page.

Browse by Year

Alternatively, you may select the Browse by Year Tab. You will then see a list of years in the 
left hand box. By selecting the year, your right hand selection box will list all the entries for 
that year.

This screen will list all the stamps that matched your search criteria will be listed in the right 
hand box of the main Search screen. Double clicking on an entry will bring up a more 
detailed display for that stamp

If the year of issue is not known (such as in some colonial issues), the year will be given as 
9999.
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Stamp Details Page
The Stamp Details page will show you more detailed information on the stamp that you 
have selected.

In Registered versions of the product, you are also able to manage the number of this 
particular stamp you have in your collection and in what condition(s) (Mint, Used, FDC or 
block of 4) that you have it. You are also able to add or remove this stamp from your wants 
list.

A Watermark image will not be displayed if it is not applicable for the identification of the 
stamp. 

Clicking on the watermark image, Issued By, Issue Type and Issue Purpose will display a 
pop up box with additional information.

Details of stamps held in your collection can be added by inserting information in the 
relevant collection details box and pressing Save Changes. Note: The Inventory is not 
activated until you have registered your product.
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The Help Menu

Support for the product is through the Stamps.AU website (http://www.stampsau.com) or 
by e-mail to support@stampsau.com. A phone request for support may also be left on 041 
930 1914. We will then contact you within 24 hours and usually less.

A current copy of this manual will be resident on the website.

About
The About menu provides details of the current version number.
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Register
Registration is required before technical support or upgrades can be supplied.  In addition, 
the inventory system in the product cannot be activated until a registration key is 
entered. This key is to be found on the instructions supplied by Stamps.AU

The registration is confirmed by posting a paper copy to Stamps.AU Pty Ltd (PO Box 167, 
Margate Qld 4019, Australia).  This enables us to notify the license holder of upgrades and 
provide technical support if required.

Registration can be transferred if the product is sold. If registration is transferred, the 
previous holder is no longer eligible for technical support or upgrades. However, they will 
continue to be supplied, if required, with information on forthcoming upgrades. These 
upgrades will only be supplied after payment of the appropriate license fee.

The Registration Update is found under Help|Register.  The necessary fields should be 
updated and Update Registration selected.  Registration Updates should be done upon sale 
of product or any change to the details of the existing license holder.
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Glossary

APCSO - The Australian Pictorial Computer Stamp Organiser

Cancelled - A stamp that has been hand cancelled by a postmarker or similar device. 
Pricing in this category has been on the basis of a light clear cancellation including a CTO.

FDC - A stamp on cover cancelled on the first day of issue. The price assumes the most 
common FDC. Special FDC/PPM may attract a premium.

Mint - A stamp that has not been cancelled. Stamp prices for the post World War II period 
are for Mint Never Hinged.

PPM – Pictorial Post Mark - See Relevant Cancel

Relevant Cancel - Postmarked by a cancellation that is relevant to the stamp.

Used – See Cancelled
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Pricing
Pricing in the catalogue is based upon retail values for good quality stamps.

Used stamps have light cancellation. Heavy cancellation will reduce value and fine 
cancellation including CTO may command a premium. 

Pricing for stamps is subject to considerable variation depending upon factors such other 
franking, destinations, and postmarking. The price shown must only be regarded as 
indicative. More specific details relating to covers can be recorded in the "Notes".

Licensing and Legal

The copyright of the database contents, images and all code not covered by the copyrights 
mentioned below are held by Stamps.AU Pty Ltd and may only be copied or altered by 
methods consistent with the normal operation of the product.
It may not be sold or otherwise distributed without express written permission from 
Stamps.AU.

This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/). 

Java™ are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. or 
other countries.

We acknowledge the kind permission of Australia Post to use its images.
 
Stamps.AU Pty Ltd cannot be held responsible for any problems or defects occurring from 
the operation of this product or the use of its database.

Only one license holder is permitted per license though this can be transferred. Transfer of 
support is only effective after acknowledgment by Stamps.AU of change of ownership.

Where Wants Lists have been submitted to Stamps.AU Pty Ltd, every reasonable effort will 
be made for fulfillment but we bear no responsibility for any circumstances arising from that 
fulfillment. Prices quoted in the Organiser are a guide only and does not imply that 
Stamps.AU Pty. Ltd. can supply them at the catalogue value.
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